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Getting Started

 

Adobe

 

®

 

 Photoshop

 

®

 

 CS delivers powerful, industry-standard, image-editing tools for 

professional designers who want to produce sophisticated graphics for the Web and for 

print. Included with Photoshop CS is ImageReady

 

™

 

 CS and its versatile set of Web tools 

for optimizing and previewing images, batch-processing images with droplets in the 

Actions palette, and creating rollovers and GIF animations. Photoshop and ImageReady 

combined offer a comprehensive environment for designing graphics for the Web. 

 

About Classroom in a Book

 

Adobe Photoshop CS Classroom in a Book

 

®

 

 is part of the official training series for Adobe 

graphics and publishing software developed by experts at Adobe Systems. The lessons 

are designed to let you learn at your own pace. If you’re new to Adobe Photoshop or 

ImageReady, you’ll learn the fundamental concepts and features you’ll need to master the 

programs. And, if you’ve been using Adobe Photoshop or ImageReady for a while, you’ll 

find that Classroom in a Book teaches many advanced features, including tips and 

techniques for using the latest version of these applications and for preparing images for 

the Web.

The lessons in this edition include information on many new features, such as a new 

chapter on using Smart Guides to arrange layer objects in ImageReady and new sections 

on creating and using layer comps. Other lessons incorporate other new features.

Although each lesson provides step-by-step instructions for creating a specific project, 

there’s room for exploration and experimentation. You can follow the book from start to 

finish or do only the lessons that match your interests and needs. Each lesson concludes 

with a review section summarizing what you’ve covered. 

 

Prerequisites

 

Before beginning to use 

 

Adobe Photoshop CS Classroom in a Book

 

, you should have a 

working knowledge of your computer and its operating system. Make sure that you know 

how to use the mouse and standard menus and commands, and also how to open, save, 

and close files. If you need to review these techniques, see the documentation included 

with your Microsoft

 

®

 

 Windows

 

®

 

 or Apple

 

®

 

 Mac

 

®

 

 OS 10 documentation.
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Installing Adobe Photoshop and Adobe ImageReady

 

Before you begin using 

 

Adobe Photoshop CS Classroom in a Book

 

, make sure that your 

system is set up correctly and that you’ve installed the required software and hardware. 

You must purchase the Adobe Photoshop CS software separately. For system require-

ments and complete instructions on installing the software, see the 

 

InstallReadMe

 

 file on 

the application CD.

Photoshop and ImageReady use the same installer. You must install the applications from 

the Adobe Photoshop CS application CD onto your hard disk; you cannot run the 

program from the CD. Follow the on-screen instructions.

Make sure that your serial number is accessible before installing the application; you can 

find the serial number on the registration card or CD sleeve.

 

Starting Adobe Photoshop and Adobe ImageReady

 

You start Photoshop and ImageReady just as you would most software applications.

 

To start Adobe Photoshop or ImageReady in Windows:

 

1

 

Choose Start > Programs > Adobe > Photoshop CS or choose Start > Programs > 

Adobe > ImageReady CS. 

If you have deleted the preferences file, a message appears asking if you want to edit your 

color settings.

 

2

 

Click No to close the message without editing your color settings. 

You’ll learn more about calibrating a monitor, later. (See Lesson 19, “Setting Up Your 

Monitor for Color Management,” in this book.)

 

3

 

In the Welcome Screen, select Close.

 

To start Adobe Photoshop or Adobe ImageReady in Mac OS:

 

1

 

Open the Application/Adobe/Adobe Photoshop CS folder, and double-click the Adobe 

Photoshop or Adobe ImageReady program icon. (If you installed the program in a folder 

other than Adobe Photoshop, open that folder.)

If you have deleted the preferences file, a message appears asking if you want to edit your 

color settings.
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2

 

Click No to close the message without editing your color settings. 

You’ll learn more about calibrating a monitor, later. (See Lesson 19, “Setting Up Your 

Monitor for Color Management,” in this book.)

 

3

 

In the Welcome Screen, select Close.

 

Installing the Classroom in a Book fonts

 

To ensure that the lesson files appear on your system with the correct fonts, you may need 

to install the Classroom in a Book font files. The fonts are in the Fonts folder on the 

 

Adobe 

Photoshop CS Classroom in a Book

 

 CD. If you already have these on your system, you do 

not need to install them. 

 

Installing fonts from the Adobe Photoshop CS Classroom in a Book CD

 

Use the following procedure to install the fonts on your hard drive.

 

1

 

Insert the 

 

Adobe Photoshop CS Classroom in a Book

 

 CD into your CD-ROM drive.

 

2

 

Install the font files using the procedure for the version of your operating system:

 

•

 

Windows. Drag the fonts from the CD to your hard disk and place them in your Adobe 

common fonts folder (typically in C:\Program Files\Common Files\Adobe\Fonts).

 

•

 

Mac OS. Open the Fonts folder on the CD. Select all of the fonts in the Fonts folder and 

drag them into the Library/Fonts folder on your hard disk. You can select and drag 

multiple fonts to install them, but you cannot drag the entire folder to install the fonts.

 

Copying the Classroom in a Book files

 

The 

 

Adobe Photoshop CS Classroom in a Book 

 

CD includes folders containing all the 

electronic files for the lessons. Each lesson has its own folder, and you must copy the 

folders to your hard disk to do the lessons. To save room on your disk, you can install only 

the folder necessary for each lesson as you need it, and remove it when you’re done.

 

To install the Classroom in a Book lesson files:

 

1

 

Insert the 

 

Adobe Photoshop CS Classroom in a Book 

 

CD into your CD-ROM drive.

 

2

 

Browse the CD contents and locate the Lessons folder.

 

3

 

Do one of the following: 
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•

 

To copy all of the lessons, drag the Lessons folder from the CD onto your hard disk.

 

•

 

To copy only individual lessons, first create a new folder on your hard disk and name it 

 

Lessons

 

. Then, drag the lesson folder or folders that you want to copy from the CD into 

the Lessons folder on your hard disk.

If you are installing the files in Windows 2000, you need to unlock them before using 

them. You don’t need to unlock the files if you are installing them in Windows XP or 

Mac OS. 

 

4

 

(Windows 2000 only) Unlock the files you copied:

 

•

 

If you copied all of the lessons, double-click the unlock.bat file in the Lessons folder.

 

•

 

If you copied a single lesson, drag the unlock.bat file from the Lessons folder on the CD 

into the Lessons folder on your hard disk. Then, double-click the unlock.bat file in the 

Lessons folder on your hard disk.

This final step is not necessary for Windows XP or Mac OS.

 

Note: 

 

As you work through each lesson, you will overwrite the start files. If you want to restore 

the original files, recopy the corresponding Lesson folder from the 

 

Adobe Photoshop CS 

Classroom in a Book

 

 CD to the Lessons folder on your hard drive.

 

Restoring default preferences

 

The preferences files store palette and command settings and color-calibration infor-

mation. Each time you quit Adobe Photoshop or Adobe ImageReady, the positions of the 

palettes and certain command settings are recorded in the respective preferences file. 

When you use the Adobe Color Management Assistant, monitor-calibration and color-

space information is stored in the Photoshop preferences files as well. Any selections you 

make in the Preferences dialog box are also part of this type of application file.

At the beginning of each lesson in this book, you will be told to reset the default prefer-

ences, using a three-key combination. This deletes any custom color-calibration infor-

mation that you may have configured earlier in the session. It also deletes any options you 

may have selected in the Preferences dialog box.

You can ignore the instructions to reset your preferences. If you do so, be aware that the 

tools, palettes, and other settings in your Photoshop CS application may not match those 

described in this book, so you’ll have to be slightly more resourceful in finding things. 

With that in mind, you should be able to do the lesson without other difficulties.
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ADOBE PHOTOSHOP CS

 

Classroom in a Book

 

Saving your monitor-calibration settings is a simple procedure that you should perform 

before you start work on this book. (See “To save your current color settings:” on page 5.) 

If you have not yet custom-calibrated your color monitor; this procedure is unnecessary.

Saving the options you’ve selected in the Preferences dialog box is more complicated on 

the newer Windows and Macintosh operating systems and beyond the scope of this book. 

If you are not sure how to do this yourself, get help from your group’s Network Adminis-

trator. Otherwise, you could simply keep a record of preferences that you’ve customized 

and then restore them manually after you finish these lessons.

 

To save your current color settings: 

 

1

 

Start Adobe Photoshop.

 

2

 

Choose Edit > Color Settings.

 

3

 

In the Color Settings dialog box, examine the Settings option.

 

•

 

If the Settings option is Custom, go on to Step 4 of this procedure.

 

•

 

If the Settings option is anything other than Custom, click OK to close the dialog box. 

You do not need to do any more of this procedure.

 

4

 

Select the Save button. (Be careful to select Save, 

 

not

 

 OK.)

The Save dialog box opens to the Settings folder, which contains various files with the .csf 

extension.

 

5

 

In File Name, type a descriptive name for your color settings. Then click Save.

 

6

 

In the Color Settings Comment dialog box, type any descriptive text that will help you 

identify the color settings later, such as the date, specific settings, or your workgroup.

 

7

 

Click OK to close the Color Settings Comment dialog box, and again to close the Save 

dialog box.

 

To restore your color settings:

 

1

 

Start Adobe Photoshop.

 

2

 

Choose Edit > Color Settings.

 

3

 

In the Settings pop-up menu in the Color Settings dialog box, select the color-settings 

file you defined in the previous procedure.

 

4

 

Click OK.
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Additional resources

 

Adobe Photoshop CS Classroom in a Book 

 

is not meant to replace documentation that 

comes with the program or to be a comprehensive reference for every feature in 

Photoshop CS or ImageReady CS. Only the commands and options used in the lessons 

are explained in this book. For comprehensive information about program features, refer 

to any of these resources:

 

•

 

Photoshop Help, which is the complete version of the user guide built into the Adobe 

Photoshop CS application. You can view by choosing Help > Contents (Windows) or 

Help > Help Contents (Mac OS). For more information, see Lesson 1, “Getting to Know 

the Work Area.” 

 

•

 

The Adobe Web site (www.adobe.com), which you can view by choosing Help > 

Adobe Online if you have a connection to the World Wide Web.

 

•

 

The 

 

Adobe Photoshop CS User Guide

 

, which contains most of the material included in 

the Help system. If the user guide book is not included in your Photoshop CS package, it 

is available for purchase at the Adobe Web site: www.adobe.com. The Help system that is 

already built into the application contains all the information in the User Guide, plus 

additional information not included in the printed version.

 

Adobe Certification

 

The Adobe Training and Certification Programs are designed to help Adobe customers 

improve and promote their product-proficiency skills. The Adobe Certified Expert (ACE) 

program is designed to recognize the high-level skills of expert users. Adobe Certified 

Training Providers (ACTP) use only Adobe Certified Experts to teach Adobe software 

classes. Available in either ACTP classrooms or on-site, the ACE program is the best way 

to master Adobe products. For Adobe Certified Training Programs information, visit the 

Partnering with Adobe Web site at http://partners.adobe.com.
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Index

Numerics

2 Digit Serial Number option 59

4-Up tab 517

16-bit-per-channel images 422

A

Absolute Colorimetric rendering 
intent 631

Accented Edges filter 421

Actions palette 403, 404

Active Slice badge 568

Adaptive option 524

Add Anchor Point tool 318

Add Vector Mask submenu 379

additive colors 650

Adjusted option (Adobe Gamma) 642

adjustment layers

compared to layer masks 419

creating 381, 418

Curves 381

deleting 419

and ImageReady 380

Adobe Certified Expert program 6

Adobe Certified Training Providers 6

Adobe Color Management Assistant 2

Adobe Creative Suite 669

Adobe Gamma utility 634

Adobe ImageReady

starting 2, 521

Adobe InDesign 99, 114

Adobe Online 45

Adobe Photoshop

Help 39–44

starting 2, 11

Adobe Training and Certification 
Programs 6

Adobe Type Manager (ATM) 3

Adobe Version Cue 669

Align Layer Right Edges button 473

Aligned option (retouching 
tools) 224, 225, 242

aligning

layer objects 464

layer objects (ImageReady) 461

objects to guides 341, 408

text (paragraphs) 161, 352

text layers (ImageReady) 472

text on a path 166

tool options bar buttons 473

See also Snap To commands

All command 393

alpha channels 198

about 188, 437

adding and deleting 199

loading as selections 202

using 437

using to restrict painting 263

See also channels; spot channels

anchor points

about 301, 302

adding and subtracting 318

converting types 320

animated GIF images. See animations

Animation palette

options 611

using 586

animations

creating 586

layer-based 587

optimizing 612

preserving transparency 609

previewing 594

simultaneous 599

from transformed layers 595

tweening frames 607

anti-aliasing 139

Appearance option (layer comps) 176

appending brush libraries 262

application dither 526

Apply command 388

Apply Layer Comp icon 177

arrow keys 378

Art History Brush tool 255–256

artistic effects in painting 255

Auto Color command 105, 282

Auto Contrast command 105

Auto Correction Options dialog 
box 106

Auto Halftone Screen option 663

Auto Levels command 202

auto slices

promoting 489

Automate menu 73

Automatic disposal option 611

automating routine tasks 403

B

Backdrop check box 389, 390

background color 191, 382

backgrounds

about 147, 149

converting to layers 149

transparency 536, 609

trimming 544

Backward button (ImageReady)

Animations palette 594

Layers palette 594

base color 249

batch

filename assignments 59

See also automating routine tasks

Batch Rename command 59

Bevel and Emboss layer style 386

Peachpit Press/Scott Design



INDEX678

bitmap images 11, 337

See also vector graphics

black and white tonal ranges 443

 See also grayscale images

Black Eyedropper tool 443

black foreground color 215

black point value 443

blend color 249

blending modes 285–288

about 249

for brushes 257

Fade command 421

for layers 154, 413

See also names of individual 
blending modes

Blending Options command 383

Blur tool 254

borders

adding 393

area, creating 266

brightness

contrast and (monitors) 638

images. See tonal range

browser dither 526, 533

browser. See File Browser, Web 
browser

brush libraries 261

brush strokes 255, 287–288

Brush tool 30, 253, 307

brushes

custom shapes 267

customized presets 264

importing libraries 261

opacity 254

Scattering options 265

Shape Dynamics options 265

size, adjusting 254

specialty shapes 258

Brushes palette 30

viewing options 258

See also brush libraries

C

calibration. See monitor calibration

cameras, EXIF data 65

Canvas Size command 266

center, drawing selections from 131

centering imported images 275

Channel Mixer command 438, 440

channels

about 437

CMYK 293

creating 213

full-color preview 215

loading as selections 201, 215

masks saved as alpha channels 188

maximum 198

mixing 440

printing 663

R, G, B, and RGB 292

RGB 438

saving selections as 197

showing and hiding 197

See also alpha channels; spot 
channels

Channels palette 197, 438

characterization 633

checkerboard backdrop 152

checking spelling 170–171

checkmark icon (tool options bar) 346

CIE LAB 629, 631

circles, selecting 131

Classroom in a Book, system 
requirements 2

Click rollover state 556

clipping

layers 376, 387

Subtract From Shape Area 
option 344

See also masks

Clone Stamp tool 224, 241

closed paths 299

closing

all palettes 36

File Browser 14

CMM.  See color matching module

CMS.  See color management

CMYK 95, 114

color model 293, 650

process colors 649

Color Balance command 105

Color blending mode 286, 414

color casts 105, 282

color channels 437

color codes

slice borders 564

color composite, printing 663

color corrections 103

Auto Color 105

out-of-gamut colors 655

selective 106

Shadow/Highlight 102

sharpening images 113

color curves 381

Color Dynamics (brush options) 269

color gamuts 293

color management

conditions 634

Mac OS monitors 634

out-of-gamut colors 655

overview 629

parts of system 630

Windows monitors 634

See also ICC profiles

color mapping, defined 629

color matching module (CMM) 631

color model 631

color modes, four-color process 
ink 114

Color palette

exclamation point icon 655

limiting colors 526

simulating colors 526

color picker 443

color printing 436

Color Reduction Algorithm 523

color reduction options 524

color separations 663, 665
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Color Settings dialog box 651

color space 629, 655

Color Swatch Name dialog box 261

color swatches, creating 260

Color Table palette (ImageReady) 525

Colored Pencil filter 212

colorizing 289

colors

additive 650

blending modes and 249

CMYK 649

Color Match command 429

converting to grayscale 413, 438, 
453

cropping by 544

desaturating 413

device-independent 629, 631

gamut 649

inverting 132

limiting 524, 526

locking 530

managing. See color management; 
reducing colors

out-of-gamut 629

PANTONE 446

removing 413, 453

resetting to default 382

RGB 649

selecting by. See Magic Eraser tool; 
Magic Wand tool

subtractive 650

Combine button 349

command settings, preferences for 4

Commission Internationale 
d’Eclairage (CIE) 629

Commit Any Current Edits 
button 351

Compatibility check boxes 60

composite channel view 197

constraining

direction of gradients 159

direction of movement 134

path angles 304

constraining tools 19

Contents screen (Help) 40

context menus 34

contrast

brightness and (monitors) 638

images. See tonal range

Convert Point tool 318

converting

backgrounds to layers 147

color to grayscale 413, 438–441, 453

corner and curve points 320

grayscale to RGB 453

RGB to CMYK 659

Copy command 135

Copy Merged command 135

copying

including pixel dimensions 135

layer groups (ImageReady) 465

layers from other files 174

layers in ImageReady 462

layers or selections 135

paths 377

while moving 133

copyright symbol 496

corner points, converting 320

correcting flaws in images 222

correcting mistakes 255

Create a New Set button 380

Create New Fill Or Adjustment Layer 
button 381

Create New Layer Comp button 175

Create Rollover State button 560

Create Slice From Selection 
command 572

Create Warped Text button 354, 560

creating

Web photo galleries 76

Crop tool 100, 140

cropping

by color or transparency 544

using Crop tool 100, 140

cropping shield 100

Current Path command 359, 379

curved path segments

converting to straight path 
segments 320

drawing 309

using few points 322

Curves (adjustment layers) 381

Curves command 21

Curves dialog box 381

Custom (rollover state) 556

Custom Colors dialog box 446

Custom command (proof setup) 654

custom Help topics 42

Custom option (color reduction) 524

customizing

brushes 267

colors 446

keyboard shortcuts.  See Photoshop 
Help

preset brushes 264

workspaces 247, 521

Cut command 135, 448

D

darkening images 21

Default Foreground And Background 
Colors icon 28, 215, 382

defaults

colors 215, 353, 382

monitor profiles 643

restoring preferences 4

Web browser 497

workspace arrangement 248

defining

color swatches 260

custom brushes 267

patterns 227

delays (animations) 602

Delete Anchor Point tool 319

Delete File button 56

deleting

files (File Browser) 56

keywords 70

deleting the Settings file 11
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Desaturate command

in ImageReady 453

in Photoshop 413

See also saturation

desaturating 289

Description option 66

descriptions, printing 661

Deselect command 19, 442, 449

deselecting 19

deselecting paths 311, 346

Destination option (Patch tool) 235

destination profile, defined 631

device-independent color 629, 631

dictionaries 170–171

digital camera EXIF data 65

digitized images 11

Direct Selection tool 302, 312

direction lines and points

about 302

drawing 309

removing 323

See also guides; paths; strokes 299

Dismiss Target Path button 346, 360, 
379

Display Calibration Assistant 
(Mac OS 10) 634

Distort command 363

Distribute Layer Vertical Centers 
button 473

dithered transparency 545

dithering

application dither 526

browser dither 526, 533

colors 526

optimized animated GIFs 612, 623

transparency and 546

Divide Slice command 563

Do Not Dispose option 611

document window. See image window

Dodge tool 110

Don’t Flatten option 442

Down rollover state 556

dragging

copying and 133

importing image layers 150

lesson files from CD 4

drawing

closed paths 312

complex paths 315–318

curved paths 309

elliptical paths 346

polygon paths 344

straight-line paths 300

See also shape layers

Drop Shadow layer style 386, 545

Dune Grass brush shape 258

duotones 453

Duplicate command 394

Duplicate Current Frame button 594, 
604

duplicating

frames 594, 604

images 394

layer comps 178

layer groups 465

layers 169, 387

layers in ImageReady 462

multiple layers 476

paths 377

E

Edge Highlighter tool 204

edges. See selection borders

Edit Layout button 88

edit mode 351

editing text

formats without selecting 
words 474

in HTML 495

editing tools

for channel masks 199

for text. See Type tool

for paths 303

Effects list 165

Ellipse tool 346, 377

Elliptical Marquee tool 17, 122, 129

E-Mail Feedback option 84

Embedded Profile Mismatch 
notice 653

Encapsulated PostScript (EPS) 
format 659

enlarging

image area 266

See also resizing; zooming

EPS Options dialog box 659

exclamation point icon 655

expanding palettes 37

Extract command 203

extracting areas from 
backgrounds 203, 208, 284

eye icon 151, 439

eyedropper tools 107

See also Magic Wand tool

F

Fade command 421

fastening points (selections) 138

Feather command 139

feathering edges

selections 139

See also dithering

feedback Web page 76

File Browser 49

closing 14

menu bar 52, 53

opening files 13

Preview palette 24

previewing lesson files 222

File Browser button 12, 13

File Info command 660

file size

compressing 514

flattening and 166

identifying 394

limiting colors and 526

resolution and 98
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files

flattening 394

formats 514

importing 150, 166

information 660

metadata 65

opening 13

opening bitmap images 11

previewing (File Browser) 53

Fill Path With Foreground Color 
button 350

Fill Subpath command 307

Fill tool (Extract dialog box) 205

filling paths 306

film-compositing technique 113

filter dialog boxes 212

Filter menu 389

filters

applying to channels 212

applying to images 420

fading effects of 421

Pattern Maker 227

performance issues 420

previewing and applying 422

special effects 399

Find All Remote Slices command 581

First Frame button 594

Fisheye option (warped text) 561

Fit on Screen command 132, 136

Flag button 56

Flagged And Unflagged option 57

flagging files 56

Flatten Image command 167, 274, 394

flattening layers 166, 240

folder icons in Layers palette. See layer 
sets

Folders palette 14

illustrated 52

fonts

installing 3

setting properties for 25, 168, 474

Force Foreground option 208

foreground color 191, 382

Foreground Color swatch 26

Foreground To Transparent 
gradient 383

formatting text 474

Forward button

Animations palette 594

Forward button (ImageReady)

Layers palette 594

four-color printing 95, 436

4-Up tab 517

frames (animations)

creating intermediate 606

default 592

navigating 593

time delay 602

tweening 607

framing images 271

Free Transform command 599

G

gamma

adjusting 103, 104

target 640

Gamma option 639

gamut 293, 629

out-of-gamut colors 655

RGB and CMYK color models 649

Gamut Warning command 655

Generate button 272

GIF 128 No Dither option 523

GIF file format

animation support 609

compressing 514

gradient color bar 158

gradient picker 158, 214, 383

Gradient tool 158, 214, 382

gradients

fill 289

masks 213

opacity 160

radial 417

transparency 383

graphs, for adjustment curves 382

Gray channel 448

gray values in masks 199

Grayscale command 442, 453, 664

grayscale images

converting color images to 413, 438

halftone screen 663

painting 289

replacing selection with spot 
color 448

Grayscale mode

Monochrome option 441

for quick masks 191

Group Layers command 
(ImageReady) 463

Group Slices Into Table button 564

Group With Previous command 614

Group With Previous Layer 
option 253

grouping

palettes 36

grouping layers 252, 379

guides

creating 408

hiding and showing 341, 437

snapping to 341, 408

Guides command 340

H

halftone dots 664

halftone screens 98, 663

Hand tool 138

Hard Light blending mode 285, 455

Hardware option 640

Healing Brush tool 229–231, 238, 241

Help 39–44

creating custom Help topics 42

keywords, links, and index 41

hidden areas (Quick Mask mode) 283

hidden tools 17

Hide Auto Slices button 489

hiding

guides 341

layers 151
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highlights 110

adjusting tonal range 103, 104, 443

painting 252

shadows and 105

Histogram palette 103

histograms 104, 444

History Brush tool 236, 241, 257

history painting tools, about 255

History palette 31, 231, 233

history states preferences 33

See also Undo command

ImageReady

hotspots

image maps 499

HTML

code (previews) 543

tables 484

and No Image slices 495

HTML And Images option 581

hue 106, 657

hue, saturation, and lightness 106

Hue/Saturation command 657

I

ICC profiles

about 631

embedding into images 650

loading in Adobe Gamma 636

See also color management

identifying tools 16

Image Dimensions option 525

image maps 483, 497–508

See also slices

image resolution 95, 97

Image Size command 135

image window 13

checkerboard backdrop 152

editing masks in 191

ImageReady

Help 39–44

ImageReady Help command 40

images

bringing into Photoshop 11

continuous-tone 11

cropping 100, 140, 544

darkening by Curves adjustment 21

deleting 55

duplicating 394

extracting 203

maximum number of channels 198

optimizing for Web 514

optimizing JPEGs 517

rotating 54

sharpening 113, 445

slicing 485

using as brush shapes 267

viewing 53

Web file formats 514

importing image layers 150, 275, 384

index

in Help 41

information

standards 660

 See also metadata

ink solidity, simulating 446

Inner Shadow layer style 275

installing, fonts and lesson files 3

InstallReadMe file 2

Interactivity Palette Locations 
workspace 588

International Color Consortium 
(ICC) 631

International Press 
Telecommunications 
Council 660

Inverse command 20, 212, 441

Invert command 132

inverting

colors 132

inverting selections 20

J

JPEG file format 514

Jump To ImageReady button 521

jumping between applications 39

K

keyboard shortcuts

brush opacity 254

brush size 254

centering imported images 275

constraining selections with 19

copying layers in ImageReady 462

customizing.  See Photoshop Help

default colors 353

Direct Selection tool 302, 312

duplicating paths 378

filters 423

loading selections 202

moving selections 129

nudging paths 378

nudging selections 130

opacity 415

pen tools 299

setting cloning samples 225

in tooltips 16

Web browser preview 595

zooming 192

See also complete listing in 
Photoshop Help

keywords 66–71

applying 68

defining 66

deleting 70

editing 69

in Help 41

Keywords palette 52, 67

knockout layers 382

L

language dictionaries 170–171

Lasso tool 122, 135

Last Document State (layer 
comps) 177

layer comps 172–182

duplicating 178

New Layer Comp dialog box 176

visibility changes 174
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layer groups

about 469

duplicating 465

modifying objects 470

transforming 467

layer groups (ImageReady) 463

layer masks

compared to adjustment layers 419

from pasted selection 135

See also masks

Layer Select tool 461, 469

layer sets 168

adding layers to 387

applying changes to 467

compared to layer groups 
(ImageReady) 469

creating 380

expanding and collapsing 250

renaming 380

Layer Style dialog box 163, 383

layer styles 386

Drop Shadow 545

Inner Shadow 275

layer comps and 179

Outer Glow 162

Pattern Overlay 164

rollovers 569

Stroke 163

Layer Via Copy command 328

layer-based slices

creating 494

layers

about 147

adding a vector mask 379

adjustment 380, 381

adjustment layers 418

animating with 587, 589

background 147

blending modes 154, 413

changing order of 153

compared to channels 199

converting to and from 
background 149

copying from other files 174

copying in ImageReady 462

creating by copying 328

creating sets (folders) 380

deleting 414

duplicating 169, 387

duplicating for retouching 237

flattening 394

grouping 252, 379

hiding and showing 151

image thumbnails 147

knockout 382

linking 155, 614

liquifying 388

merging 363, 418

merging with masks 388

nesting (layer sets) 168

opacity 154

rasterizing 388

selecting 151

shape 342

styles 162

transparency 152

tweening 606

type 160

using to create slices 494

vector masks 387

visibility and rollovers 565

Layers palette

Effects lists 165

eye icon 151

functions 147

layer sets 168

link icon 156, 360

stacking order 153

thumbnails in 343

layouts for printing 85

Levels command 103, 443

libraries, brushes 261

lightness 106, 110

Linear Gradient button 158, 382

lines. See guides; paths; strokes

link icon 156, 360, 620

linking

layers 155

slices to URLs 489

linking layers 614

links in Help 41

Liquify command 388–389

liquify tools 389

Load Channel As Selection 
button 212, 215

Load Path As Selection button 327

Load Selection command 201, 413, 
440, 572

Lock button (Color Table palette) 530, 
532

lock icons (Layers palette) 148

Lock Transparent Pixels option 252

Luminosity blending mode 155, 286

M

Mac OS option (color reduction) 524

Macintosh Default option (Adobe 
Gamma) 640

Magic Eraser tool 152, 539

Magic Wand tool 123

Magnetic Lasso tool 122, 137, 410

magnifying. See zooming

Make Selection command 327

Make Work Path From Selection 
button 326

managing colors.  See color 
management; reducing colors

mapping colors to transparency 535

marquee

cropping 100

selecting 122–123

See also selection borders

masks

adding to selection 202

color and editing effect 191

creating 189

defined 106

editing 191, 199

gradient 213
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merging with layers 388

partial transparency 213

permanent (alpha channels) 188, 
198

quick masks 188–191

rasterizing 388

restoring 196

saving as alpha channels 188

subtracting from a selection 202

temporary (Quick Masks) 198

See also adjustment layers; channels; 
layer masks

Master Diameter option 258

Match Color command 429

Matte swatch (Optimize palette) 547

matting, simulating 266

Measure option 641

melting. See Liquify command

memory. See performance issues; 
system requirements

menu bar 12

File Browser 53

menus

context 34

in File Browser 52

Merge Visible command 418

merging layers 363, 418

See also flattening layers

Mesh check box 390

metadata 65

from digital cameras 65

Version Cue 674

Metadata palette 52, 65

midtones, adjusting in images

Curves graph 381

histograms 103, 104

missing fonts, adding to system 3

mistakes, correcting 29

mixing color channels 437

mixing colors. See blending modes; 
Color palette; color picker

moiré patterns 663

monitor

phosphors 638

profiles 633, 643

monitor calibration

about 633

Adobe Gamma 634

Mac OS 634

white point 635, 640

Windows 634–642

wizard (Windows) 635

monitor resolution 98

Move tool 26

selecting temporarily 129

using to import layers 150

moving

layer sets 387

layer stacking order 153

selected pixels (image areas) 132

selection borders 127

selections 18

thumbnails 58

moving selections

constraining 134

using arrow keys 130

Multichannel mode, spot 
channels 447

multilingual spelling checker 171

Multiply blending mode 251, 259, 285, 
454

N

Navigator palette 23

negatives, color 132

nesting layers 168

New Action button 404

New Brush button 265

New Channel button 213

new frame button. See Duplicate 
Current Frame button

New Keyword Set command 67

New Layer Based Slice command 494

New Layer button 169, 238

New Layer dialog box 252, 253

New Slice Set 571

New Snapshot button 234, 255

New Spot Channel dialog box 446

Newspaper Association of 
America 660

No Image slices 495

None rollover state 556

Normal (rollover state) 561

number of history states 33

numbers

for file sizes 166

scrubbing to set values 22

O

online Help. See Help

online services 45

opacity

animations based on 607

of brushes 254, 257, 415

of layers 154

in tweened frames 607

open paths 299, 302

Open Recent command 173

Optimize By Bounding Box 
option 612

Optimize By Redundant Pixel 
Removal option 612

Optimize palette (ImageReady) 522

optimizing 290–291, 514

JPEG format 517

organizing

slices in slice sets 571

organizing layers

layer sets 168

linking 155

Original image view 587

Other Keywords category 71

Out rollover state 556

Outer Glow layer style 162

outlines. See paths; strokes

out-of-gamut colors 629, 655
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output resolution 98

Over rollover state 556

Over state 560

overprinting colors 447

P

paint bucket icon 261

paintbrush icon (Layers palette) 148

paintbrush tool. See Brush tool

painting 246–278

blending modes 287–288

channel masks 199

over grayscale 289

in preset shapes 258

in Quick Mask mode 283

tools 199

palette menus 26

palette well 12

docking palettes 36–37

opening docked palettes 30

palettes 12

overview 24, 26

closing all 36

defining workspaces 247–248, 521

expanding and collapsing 37

in File Browser 51

locations 36

moving groups 36

opening from Window menu 36

resetting to default workspace 248

setting position of 4

PANTONE colors 446

Paste command 135, 449

pasting layers or selections 135

Patch tool 235, 239, 241

Path Selection tool 377

paths

about 299

adjusting and moving 302

closed 305

combining 315, 349

constraining angles of 304

converting to selections 327

creating 299, 325

curved 309

deselecting 346

duplicating 377

editing angle and length 303

ending 301, 304

filling with color 307, 313, 350

hiding and showing 308, 311

nudging 378

painting 306

printing and 299

saving 310

selecting and deselecting 305, 311, 
377

stroking with color 306, 313

subtracting from 327

text on 166

thumbnail previews 300

See also anchor points; work paths

Paths option 300, 377

Paths palette 300

Pattern Maker filter 227, 271–273

Pattern Overlay layer style 164

pattern picker 228

Pattern Stamp tool 228, 241

patterns

applying 228

creating 226, 271

PDF presentations 73

Pen tool 297

Perceptual (Images) rendering 
intent 631

Perceptual option (color reduction 
algorithm) 523, 524

performance

and history states 33

performance issues

filters 420

History palette 232

phosphors, monitor 638

Photoshop EPS format 656

Photoshop Help command 40

Photoshop work area 12

pickwick 576

picture frame, simulating 271

Picture Package 85

pixel dimensions

for new channels 198

pasting and 135

resolution and 97

pixels

about 11

changing in a selection 132

changing permanently 418

compared to vectors 309

dimensions. See pixel dimensions

Play button 594

PNG file format, compressing 515

Polygon option (image maps) 499

Polygon tool 344

Polygonal Lasso tool 122

Pond Ripples option 423

Position option (layer comps) 176

Preferences

History States 33

preferences

Adobe Online 45

command settings 4

file 4

number of history states 232

restoring to default settings 4

Slice tool icon 488

Transparency & Gamut 656

Version Cue 671

Preview Document button 562

Preview In command 594

Preview In Default Browser 
button 496, 548

Preview option 445

Preview palette 24, 52

previewing

animations 593

files, in File Browser 52, 222

optimized images, in Web 
browser 543

slices in Web browser 496
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Print command 665

Print With Preview command 657, 
661

printer resolution 98

printing

captions 661

CMYK 436

color channels 663

color composite 663

color separations 665

four-color 436

general options 660

halftone screen attributes 663

layouts 85

paths and 299

printing inks, simulating 446

process colors 446, 649

profiles.  See ICC profiles

Promote command 556

promoting auto slices 489, 556

Proof Colors command 655

proof setup 654

Q

Quick Mask mode button 190

quick masks 188–191

color illustrations 283

R

RAM. See performance issues; system 
requirements

ranking files (in File Browser) 62–64

raster images

bitmaps versus vectors 337

masks 388

rasterizing layers 388

rearranging slices 564

rearranging thumbnails 58

Reconstruct tool (Liquify filter) 392

recording actions 403–407

Rectangular Marquee tool 17, 449

red overlay (Quick Mask mode) 190

Redo command (ImageReady) 34

reducing

file size 166

number of colors 524, 526

See also flattening

reference color space.  See 
device-independent color

Relative Colorimetric rendering 
intent 631, 654

remapping highlights and 
shadows 105

Remote badge 577

remote rollovers 556, 575, 582

pickwick 576

removing image areas 224

renaming

alpha channels 198

files 59

keywords 69

layer sets 380

snapshots 234

rendering intents 630, 631, 654

repairing missing areas 224

Replace Color command 106, 107

Reset Brushes command 262

Reset Palette Locations command 248

resetting default colors 382

resetting sample areas (Clone Stamp 
tool) 226

resizing

palettes 37

panes in File Browser 54

thumbnails in palettes 349

See also scaling

resolution. See image resolution; 
monitor resolution; printer 
resolution

Restore To Background option 611

restoring areas (History Brush 
tool) 257

result color 249

retouching

about 94

on duplicate layers 237

sequence of tasks 95

See also Clone Stamp tool; Healing 
Brush tool; Patch tool; Pattern 
Stamp tool

reviewing layer comps 181

RGB Color command 453

RGB color mode 95

RGB color model 293, 649

Ridges option 423

right-click menu. See context menus

Rollover State Options dialog box 569

rollover states 556

changing 569

rollovers

about 554

correcting Normal state 573

generating Web pages 580

layer styles and 569

Normal 561

Over 560

previewing 561

remote 556

remote, creating 575

Rotate buttons 55

Rotate command 137

rotating

images, with the Crop tool 100–101

selected areas of an image 137

rotating images 54

rubylith 190

S

Same as Hardware option 642

samples, setting

Clone Stamp tool 226

Healing Brush tool 230

Patch tool 235

Pattern Maker 226

saturation 106, 111, 657

color illustration 282

See also Desaturate command

Saturation (Graphics) rendering 
intent 631

Save As dialog box 167
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Save For Web dialog box

4-Up tab 517

Save Optimized As command 581

Save Optimized command 548

Save Path dialog box 301

Save Selection command 411

Save Workspace command 248

saving

custom brushes 267

custom patterns 227

monitor profiles 643

work paths 301

workspaces 247, 589

scaling 133

Scattering options (brushes) 265

scissors icon 129

screen angle 663

screen frequency 98, 663

Screen option 663

scrolling

Navigation palette 23

scrubbing 22

searching (File Browser) 71

Select From Shape Area button 379

Selected rollover state 556

selecting

about 122

anchor points 305

areas by color 123

circular areas 131

earlier states of work 232

entire images 393

extracting 203–210, 284

flagged files 57

freehand lines 135

from center 131

loading 202

moving and 122

parts of a selection 126, 189

paths 305, 377

in Quick Mask mode 283

in straight lines 135

text 27

tools 122

unselected areas 124

using multiple selection tools 125

selection borders

anti-aliasing 139

converting to masks 189

converting to paths 326

feathering 139

hiding and showing 130, 263

moving 127

nudging 130

Selection Edges command 130

selections

adding to and subtracting from 124

constraining 19

copying while moving 133

extracting 203, 284

inverting 20, 212

loading 202, 215, 413

masks and 189

moving 18

quick masks and 283

rotating 137

saving as alpha channels 197, 411

softening edges of 139

subtracting from 125, 126, 327

Selective option 524

Separations option 665

sets

slices 571

Shadow/Highlight command 102

shadows

adjusting tonal range 103, 104, 443

Drop Shadow layer style 386, 545

painting 252

Shape Dynamics options 265, 268

shape layers 342, 343

custom shapes 365

Polygon tool 344, 361

Rectangle tool 340

Shape option (image maps) 499

shapes of brushes 258, 267

sharpening images 113, 445

shifting to Web-safe colors 533

showing

guides 340

layers 151

Single Column Marquee tool 122

Single Row Marquee tool 122

16-bit-per-channel images, and 
filters 422

size

of brushes 254

of files 394

of palettes 37

Slice Options button 490

Slice Options dialog box 490

Slice palette 495

Slice Select tool

in toolbox 489

slice sets 571

slice symbols 568

Slice tool

pointer-icon preferences 488

slices

about 483

creating from layers 494

creating with Slice tool 485

dividing 563

linking to URLs 489

naming 489

No Image slice option 495

promoting auto slices 556

promoting auto slices to user 
slices 489

rearranging 564

resizing 578

slide show 73

Small List command 383

Smart Guides 461, 466

smoothing selections 139

Snap To commands 347, 409

snapshots 255

about 231
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restoring areas to previous 
states 256

taking 233

using to save trials 267

using with History Brush tool 236

Snap-To

Smart Guides 461

soft-proofing 654

Solidity option 446

sorting

by rank 62

source (history brushes) 256

Source option (Patch tool) 235

source profile, defined 631

spacing

divided slices 563

special effects with filters 399, 420

spelling checker 170–171

Sponge tool 111, 282

spot channels

about 437

creating text in 451

merging 447

setting up 446

See also alpha channels; channels; 
spot colors

spot colors

about 436, 446, 447

applying 448

removing 449

replacing grayscale selection 
with 448

screening 450

See also spot channels

stacking order, of layers 153

Standard mode 190, 194

startup messages 11

status bar 15, 524

Stroke command 393

Stroke layer style 163

Stroke Path With Brush button 314

Stroke Subpath command 307

strokes

adding to paths 306

removing 257

smoothing edges 254

stroking paths 306, 313

Style option (Art History Brush 
tool) 256

styles

layer 386

painting strokes 255

subpaths 306, 311

Subtract From Selection option 327

Subtract From Shape Area option 344

subtractive colors 650

Swatches palette 27, 159, 253, 260

swatches, creating 260

Switch Foreground And Background 
Colors icon 191, 195

switching

between Photoshop and 
ImageReady 39

foreground and background 
colors 353

SWOP 631

symbols for slices 568

system color palettes 533

system requirements (for lessons) 2

T

Tab keyboard shortcut 36

tables 563

target gamma, selecting 640

Target option 490

target values, setting highlights and 
shadows with 443

temporary masks 198

text

adding 160

editing 165

formatting 474

legibility 96

on paths 166

selecting 27

setting characteristics for 25

setting colors for 475

specifying spelling 
dictionaries 170–171

See also type layers

text layers

aligning in ImageReady 472

thumbnails

adjustment layers 382, 419

in File Browser 14

identifying 228

layer images 147

in Layers palette 343

paths 300

in Paths palette 345

patterns 228

rearranging 58

size options in palettes 349

thumbnails pane 52

Tight Short brush option 256

Tile Boundaries option 272

tiled patterns 271

time delay (animations) 602

Toggle Expanded View button 52

Toggle Slices Visibility button 561

tonal range

adjusting 103, 443

adjustment layers 380

balancing in selections 202

tool options bar 12, 24

compared to other palettes 38

toolbox 12, 15

compared to other palettes 38

tools 279–281

constraining 19

hidden 17, 122

identifying 16

keyboard shortcuts 16

for Liquify filter 389

selecting 16, 122

See also individual tool names

tooltips, for tools 16
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topics

adding to the Help menu 42

TOYO 631

transformations

bounding box 156, 599

using for animations 595

transforming

committing changes 476

distorting 363

layer groups 467

rotating 137

scaling 133

transparency

background 536

checkerboard backdrop 152

cropping by 544

dithered 545

in gradients 383

of layers 152

mapping colors to 535

methods of locking 252

of new layers 147

preserving 609

Transparency & Gamut 
preferences 656

Transparent Pixels option 544

Trash button (Layers palette) 414

triangles in tool buttons 17

Trim command 544

Turbulence tool 392

Tween button 594

Tween command 607, 609

tweening frames 606, 607

2 Digit Serial Number option 59

two-color Web graphics 453

type

on paths 166

warping 559

type layers

adding to layer sets 168–169

converting to work paths 356

creating 160

font properties 168

specifying a spelling dictionary 170

type on a path. See Photoshop Help

Type tool 25, 161, 351, 451

type, creating in spot channels 451

types of resolution 97

U

undo

Liquify dialog box 392

multiple steps (Photoshop) 255

restoring limited areas 236

See also History palette

Undo command 231

ImageReady 34

Photoshop 29

undoing actions 29–34

unlinking layers and masks 620

unlocking

lesson files (Windows 2000) 4

locked colors 531

Unsharp Mask filter 112, 445

Up rollover state 556

URLs

Adobe Online 45

linking to slices 489

Use Printer’s Default Screen 
option 665

USM. See Unsharp Mask filter

V

vector graphics

about 337

direction lines and points 309

rasterizing 388

shape layers 343

vector masks 379

Version Cue 669

View Single Gamma Only option 639

Visibility option (layer comps) 176

W

Warp tool (Liquify filter) 389

warping text 354, 560

Watercolor Light Opacity brush 262

watercolor painting 255

WBNG file format, compressing 515

Web browser

browser dither 526, 533

default 497

and Help 40

previewing animations 594

previewing HTML text 497

Target option for 490

viewing a Web gallery 80

Web Content palette

creating rollovers 560

Web file formats 514

Web option (color reduction) 524

Web pages

generating 580

Web pages, designing 485

Web Photo Gallery 76

Web-shift button 534

Wet Media Brushes brush library 262

White Eyedropper tool 443

white point (images) 443

white point (monitor) 292, 635, 640

Window menu

opening palettes 36

Windows Default option (Adobe 
Gamma) 640

Windows System palette 524

work area 9

illustrated 12

work paths

about 301

creating from text 356

saving 301, 310

See also masks

workspaces

Interactivity Palette Locations 
(ImageReady) 588

for optimizing (ImageReady) 521
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for painting 247

resetting to default 248

for Version Cue 670

Z

Zigzag filter 422

Zoom tool

shortcuts 192

zooming

levels 15

Navigation palette 23

out 16

Zoom tool 16
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